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Izmene 
v. 1.0 – Inicijalna verzija dokumenta 

 

Uvod 
Ovo upustvo je namenjeno administratorima i profesorima školskih sajtova koji učestvuju u projektu nasaskola.rs 

Nakon čitanja upustva u mogućnosti ste da samostalno menjate izgled sajta, dodajete nove stranice, slike, video 
fajlove,ankete i ostali sadržaj. Neophodno predznanje je svedeno je na minimum: snalaženje na internetu (znanje šta 
je link,šta je strana,šta je adresa sajta/strane) i osnovni rad sa programom za unos teksta kao što je word (promena 
fonta,boje,dodavanje tabele itd).  

Zamisao projekta je da administratori održavaju opšte stvari kao što je izgled sajta, slike, video, kontakt 
podatke,menije. Profesori treba da održavaju strane dodeljenje njihovim predmetima čime se podeljenim radom 
postiže visok kvalitet sadržaja za posetioce (učenike i roditelje). 

Profesorski nalozi mogu biti ograničeni na delove koji su samo njima od interesa tako da nisu opterećeni tehničkim 
aspektima. Administratori nemaju obavezu da ažuriraju kompletan sadržaj. 

Adresu Vaše škole saopšti će vam kordinator projekta, a ona će biti u formatu http://vasa_skola.nasaskola.rs 

Administratorski deo se nalazi na adresi http://vasa_skola.nasaskola.rs/admin 

Podrezumevani kreirani nalog je admin/admin. Prilikom prvog logovanja preporučuje se promena kako bi se sprečila 
moguća zloupotreba jer sve škole na početku dobijaju istu lozinku. Ovo je lako pogodljiva kombinacija i predstavlja 
sigurnosni rizik ukoliko se ostavi.  

U sledećem poglavlju počinjemo rad sa sistemom.  



 

Početni ekran 
Nakon dobijanja adrese vaše škole prva stranica koju će te videti upisivanjem adrese će izgledati kao na slici ispod. 

 

 

Sistem je sastavljen iz komponenata (modula i blokova) kako bi se omogućio lakši rad. Na sledećoj slici su označene 
te komponente. 

Meni  je deo koji omogućava navigaciju do svih bitnih delova sajta jednim klikom ili preko padajućeg menija. Postoji 
primarni meni koji nije moguće obrisati (ali je moguće menjati) i neograničen broj dodatnih sekundarnih menija 
(prikazan jedan na slici).  

Blok je gradivni deo sajta(sa leve ili desne strane sajta zavisno od izgleda) i služi da dinamički doda funkcionalnost 
sajtu. Kao tip bloka može biti meni, vesti, html, forma za logovanje ili pretragu itd. Moguća je promena i redosled 
blokova kao i dodavanje ili brisanje postojećih. 

Centralni deo sajta zauzima sadržaj. Na prvoj stranici sajta moguće je izabrati da li će se prikazati vesti ili neka druga 
stranica. Pored sadržaja postoji,zavisno od odabranog izgleda sajta, mogućnost dodavanja slike (nazvanog baner) i 
teksta uz sliku. Npr. može se iskoristiti prikaz objekta škole.  

U gornjem delu moguće je postaviti grafički logo škole . 





 

Prvo logovanje 
Prvo logovanje je moguće izvršiti preko forme sa leve strane u dnu ekrana ili 
upisivanjem adrese  http://vasa_skola.nasaskola.rs/admin 

Podrazumevano korisničko ime i šifra su admin/admin. 

Ukoliko upišete pogrešno korisničko ime i šifru dobićete grešku o tome. 

 

 

 

Nakon logovanja dobićete sledeći izgled ekrana koji Vam daje mogućnost uređivanja sajta.   

 



Klikom na neko crveno dugme otvara se podmeni . Svuda u sistemu olovka označava mogućnost promene, crveni x 
mogućnost brisanja, a lupa pregled sadržaja kao korisnik. 

Podešavanja 
Nakon logovanja u administraciju potrebno je da podesite osnovne stvari. Podešavanja su podeljena u tri 
kategorije:Generalno, Kontakt i Tema. 

Generalna podešavanja 

 

Pored naziva i slogana sajta(škole) potrebno je 
izabrati kako će izgledati početna strana. Postoji 
mogućnost da na početnoj strani budu vesti i u tom 
slučaju se bira broj poslednjih vesti  koji će se 
prikazati. Ukoliko se odabere da početna strana 
bude neka stranica sa sajta, dobijate izbornik koja 
će to strana biti.Unos strana i vesti je obrađen u 
kasnijim poglavljima.  

Sledeća važna stavka je izgled sajta odnosno tema. 
U momentu pisanja postoji  11 predefinisanih tema 
koje će se vremenom dopunjavati. Odabirom teme 
u potpunosti menjate izgled sajta. 

Lightbox prikaz galerije omogućava da se slike u 
galeriji prikazuju u okviru iste strane.  

Broj slika po redu u galeriji daje mogućnost 
podešavanja koliko će biti prikazano slika po redu. 
Preporuka je da to bude od 3-5 slika, tačan broj 
zavisi od izgleda teme i treba ga eksperimentalno 
menjati(3 je bezbedan broj) 

Sve izmene se snimaju tek nakon klika na dugme 
promeni! 

 

 

 

 

 

 

 

 



 

 

Kontakt 

Na ovoj stranici imate mogućnost da podesite email adresu na koju će se putem kontakt forme slati email poruke sa 
sajta. Drugo polje predstavlja unos generalnih kontakt podataka kao što je adresa, telefoni...  

 

Tema 

Na ovoj stranici moguće je podesiti 
stvari specifične za svaku temu. Svaka 
tema daje određeni stepen slobode. 
Npr. kod nekih tema moguće je 
podesiti početnu sliku (baner) i tekst 
preko te slike. Na ovom ekranu se daje 
i mogućnost uključivanja prikaza 
banera. 

Pored toga moguće je izabrati da 
umesto tekstualnog ispisa imena škole, 
postoji grafički logo. Uključivanjem ove 
opcije potrebno je klikom na 
preglednik fajlova odabrati(ili postaviti) 
grafički logo na server. Tačne dimenzije 
logo slike zavise od teme i samog logoa 
škole te je eksperimentalno potrebno 
utvrditi veličinu logoa. Ovaj korak 
zahteva poznavanje rada sa slikama i 
„osećaj“ sa piksel veličinama 



 

Strane 
Osnovni element svakog sajta su strane.  Sistem Vam daje mogućnost unosa statičkih strana (strana koje ne 
zahtevaju obradu i prikupljanje podataka). Stranice je moguće podeliti po grupama(analogija folderi na računaru),a u 
okviru grupa je moguće praviti nove stranice. Grupa je element kontrole koji se može dodeliti profesoru da ažurira.  

Predlog organizacije je da postoji osnovna grupa u kojoj će se nalaziti strane poput O školi, Dostignuća, Projekti, 
Takmičenja,smerovi u školi isl. Za svaki predmet(ili profesora) preporuka je da se kreira posebna grupa(smanjujemo 
mogućnost greške i ne opterećujemo profesore njima manje važnim podacima).U okvriru grupe trebalo bi kreirati 
jednu glavnu stranicu na koju će se linkovati iz menija, a sa koje će dalje profesori linkovati svoje ostale strane po 
logici i prirodi koja odgovara datoj grupi/predmetu. 

Npr. trebalo bi da postoje sledeće grupe Matematika, Fizika, Srpski, Biologija.... Osnovne strane. Profesori 
matematike bi dobili na ažuriranje samo grupu matematika, profesori  fizike samo grupu fizika i sl. 

Moguća je i drugačija podela po razredima, profesorima i sl. 

Samo administratori imaju mogućnost dodavanja novih grupa i ažuriranja svih stranica na sajtu. 

Nova grupa 

Za novu grupu potrebno je upisati samo ime grupe.Nakon dodavanja biće Vam ispisana poruka o uspešnosti i bićete 
na pregledu svih grupa. 

Nova strana 



 

Za unos nove strane potrebno je upisati naslov strane, zatim odabrati grupu kojoj pripada ta strana(ukoliko korisnik 
ima na raspolaganju više grupa), i na kraju uneti tekst i slike strane. Polje za unos je slično izgledu Microsoft office 
Word 2003. Ovo polje omogućava napredan unos sadržaja.Ukoliko vam nije poznat rad sa ovakvim 
sistemom,detaljno upustvo za ubacivanje slika,linkovanje i slične akcije biće objašnjenje u dodatku na kraju upustva. 

Nakon klika dodaj stranu, dobićete poruku o uspešnosti akcije. Ukoliko je akcija uspešna biće vam prikazan pregled 
strana i grupa. 

Pregled strana i grupa 

Strana pregled daje sve raspoložive grupe za korisnika. Klikom na neku od grupa izlistavaju se sve strane u grupi. 
Administratori imaju mogućnost promena imena grupe(ikonica olovke) i mogućnost brisanja grupe. Brisanjem grupe 
brišu se i sve strane iz grupe. 

(pregled grupa) 



(pregled strana u grupi) 

Ikonica olovke daje mogućnost izmene strane, ikonica x daje mogućnost brisanja strane,a ikonica lupe otvara stranu 

u novom prozoru u korisničkom režimu pregleda.  

Pored naslova strane postoji i kolona URL koja predstavlja adresu strane i koja se može koristiti za ručno linkovanje 
date strane. 



 

Vesti/Novosti 
Ovaj modul omogućava dodavanje školskih novosti na početnoj strani(ako je 
izabran takav prikaz) ili sastrane u blokove. Moguće je i direktno linkovanje na 
stranu vesti. 

Vesti/Novosti se mogu upotrebiti za promociju školskih takmičenja, objavu 
rezultata takmičenja, dostignuća, prekida u nastavi ili drugim važnim informacijama za učenike i roditelje. 

Vesti se mogu podeliti u kategorije. Jedna kategorija može sadržati i podkategorije ukoliko za time ima potrebe. 

Nova kategorija 

Prvo polje koje je potrebno upisati je naziv 
kategorije npr. rezultati. Zatim je potrebno 
odabrati roditeljsku kategoriju ili definisati 
novu kategoriju kao „Samostalnu kategoriju“.  

Ukoliko se izabere roditeljska kategorija npr. 
Takmičenja, vesti iz kategorije Rezultati će se 
prikazivati i u glavnoj kategoriji takmičenja. 

Ukoliko se izabere da je kategorije 
samostalna, ona će biti u rangu sa svim 
ostalim kategorijama prvog nivoa(neće imati 
roditelja). 

Treće polje je opis date kategorije,koji može 
ostati prazan. 

Primer i važnost kategorija se može ovako 
demonstrirati. 

 Glavna kategorija: Informacije 

Podkategorije: 

-Prva godina 

-Druga godina 

-Treća godina 

-itd. 

Korisnici vide sve vesti u kategoriji informacije,a ukoliko žele da vide samo drugu godinu mogu otići u podkategoriju. 

Nakon klika dodaj, dobićete poruku o uspešnosti akcije. 

Nova vest 

Prilikom pisanja vesti potrebno je uneti naslov vesti ,zatim odabrati kojoj kategoriji pripada ta vest. 



Polje uvod treba da predstavlja prvi paragraf vesti. Ovo polje biće prikazano na naslovnoj strani,u blokovima (ukoliko 
je takav pregled uključen) i na stranici vesti. Polje Tekst predstavlja ostatak vesti koji se dobija klikom na link pročitaj. 
Na ovoj strani biće prikazan uvod i tekst(ostatak) vesti. 

 

Polje uvod i tekst imaju mogućnost naprednog unosa teksta. 

Nakon klika dodaj, dobićete poruku o uspešnosti akcije. 

Pregled vesti  

Pregled vesti daje izbor kategorije,a u okviru kategorije pregled vesti u datoj kategoriji. 

 

Ikonica olovke daje mogućnost izmene kategorije, ikonica x daje mogućnost brisanja kategorije(i svih podkategorija i 
vesti u njima),a ikonica lupe otvara kategoriju u novom prozoru u korisničkom režimu pregleda.  



Izgled kategorije: 

 

Ikonica olovke daje mogućnost izmene vesti, ikonica x daje mogućnost brisanja vesti,a ikonica lupe otvara vest u 
novom prozoru u korisničkom režimu pregleda.  

Pored naslova vesti tu su i osnovni podaci kao što je vreme objavljivanja i koji korisnik je autor vesti. 



 

Download 
Download predstavlja mesto gde korisnici sajta(učenici) mogu preuzeti u elektronskom obliku materijal. Profesori 
mogu postavljati literaturu,arhive sa animacijama, dodatne programe, slajdove sa prezentacija i slične stvari. Ovakav 
vid materijala pogodan je za dodatna razjašnjenja gradiva, za učenike koji sporije uče, za učenike koji bi dodatno da 
nauče ili jednostavno za one koji su propustili neki čas. Dobar primer je matematika gde profesor može postaviti 
zadatke i postupak  rešenja istih. 

Organizacija fajlova je moguća po kategorija i podkategorijama. Predlog je da se naprave glavne kategorije npr. Prva 
godina, Druga Godina itd, a u njima predmeti Matematika, Fizika, Srpski itd. Korisniku se može dodeliti da održava 
neku od kategorija ili podkategorija(npr. svoj predmet). 

Kategorije je moguće zaštiti šifrom ukoliko za time ima potrebe. Fajlovi u kategoriji neće biti vidljivi i ne mogu se 
preuzeti dok se ne upiše ispravna šifra. Šifru je moguće recimo saopštiti na času. 

Nova kategorija 

Prvo trebamo upisati naziv kategorije. 

Ukoliko želimo da je kategorija zaštićena 
šifrom,trebamo upisati šifru. Upisom šifre 
kategorija, podkategorije i fajlovi će biti 
zaštićeni. 

Zatim trebamo odabrati roditeljsku 
kategoriju ili kategoriju definisati kao 
samostalnu kategoriju.  

Opis kategorije je opcion i poželjno je 
upisati ga. 

Nakon klika dodaj, dobićete poruku o 
uspešnosti  akcije.. U slučaju uspešne 
akcije bićete redirekovani na pregled 
kategorija. 

Novu kategoriju može dodati samo 
administrator. 

 

 

 

Novi fajl(dodaj fajl)  

Prvo je potrebno upisati naslov fajla, zatim odabrati kategoriju. Nakon toga potrebno je upisati putanju do fajla na 
serveru. Klikom na preglednik fajlova otvarate novi prozor koji Vam daje mogućnost izbora fajla sa servera ili 
postavljanje novog fajla na server. Dvostrukim klikom na fajl zatvarate prozor i putanaj se automatski  upisuje. 
Detaljan rad sa Preglednikom fajlova je opisan u dodatku. 



Opcioniono polje je opis fajla, koje podržava napredan unos teksta. 

 

Nakon klika dodaj, dobićete poruku o uspešnosti  akcije. U slučaju uspešne akcije bićete redirekovani na pregled 
fajlova. 

Pregled fajlova 

Pregled fajlova daje prvo 
pregled kategorija i 
podkategorija sa njihovim 
opisom. Ikonica olovke daje 
mogućnost izmene 
kategorije, ikonica x daje 
mogućnost brisanja 
kategorije(uključujući 
podkategorije i fajlove u 
njima),a ikonica lupe otvara 
kategoriju u novom prozoru 
u korisničkom režimu 
pregleda.  

 

 

 



 

Klikom na neku od kategorija otvara se prikaz fajlova u datoj kategoriji. Pored naslova fajla prikazuje se i opis. 

 

 Ikonica olovke daje mogućnost izmene fajla, ikonica x daje mogućnost brisanja fajla,a ikonica lupe otvara fajlu 
novom prozoru u korisničkom režimu pregleda odnosno ovaj link vodi na download fajla.  



 

Foto Galerija 
Vaš sajta možete dodatno obogatiti slikama sa školskih priredbi, matura , sportskih aktivnosti i radionica. 

Slike se mogu razvrstati u više albuma. Svaki album može imati opis,a svaka slika na nivou albuma može imati svoj 
opis.  

Postoje dva načina pregleda velikih slika u albumu. Sa uključenim lightbox efektom(podešavanja->generalna-> prikaz 
galerije lightbox) koji daje mogućnost pregleda slika u okviru strane bez dodatnog učitavanja. 

 



Drugi način prikaza je svaka slika na zasebnoj 
strani.

 

Slikama je pre postavljanja na internet potrebno smanjiti veličinu na nekih razumnih 1000x1000 piksela kako bi se 
lepo videle na svakom monitoru. Za ove potrebe moguće je koristiti alate poput InfranView, ACDSee, PhotoShop, 
Gimp isl.U dodatku je opisan rad sa besplatnim programom InfranView. 

Iako je sistem napravljen da sam uradi optimizacije slika, zbog eventualnog preopterećenja servera provajdera i 
bržeg postavljanja slika preporuka je da se ova optimizacija uradi pre postavljanja slika. 

Novi album 

 Za kreiranje novog albuma je potrebno da upišemo 
ime albuma i njegov opis.  Nakon klika dodaj, dobićete 
poruku o uspešnosti  akcije. U slučaju uspešne akcije 
bićete redirekovani na pregled albuma. 

Naredni korak je da postavite slike u album. Za 
naslovnu sliku albuma biće uzeta prva slika iz albuma. 
Kasnije je moguće postaviti drugu sliku za naslovnu. 



 

Dodavanje slika 

U jednom momentu moguće je dodati do 4 slike. Prvo 
je potrebno da odaberete album u koji dodajete slike 
(naknadno prebacivanje između albuma nije moguće, 
već je potrebno brisanje slika i ponovno dodavanje). 

Nakon toga uz pomoć forme odaberite sliku sa vašeg 
računara i upišite opis slike. 

Kada završite kliknite dodaj. Proces postavljanja slika 
može biti dugačak, zavisno od veličina slika i brzine 
internet konekcije. Ne prekidajte proces dok se ne 
završi. 

 

Nakon završenog procesa, dobićete poruku o 
uspešnosti  akcije. 

Postupak ponavljati dokle ne dodate sve željene slike u 
album. 

 

 

 

 

 

Pregled albuma 

Na prvoj stranici imate listu svih albuma. Pored naslovne slike albuma, naslova,opisa imate i prikaz URL(adrese) 
albuma.  

 



Ikonica olovke daje mogućnost izmene albuma i slika u njemu, ikonica x daje mogućnost albuma,a ikonica lupe 
otvara album novom prozoru u korisničkom režimu pregleda. 

Prilikom izmene albuma imate mogućnost promene naslova i opisa albuma, kao i promenu opisa svake slike. 

 

Pored svake slike postoji polje Obriši koje će obrisati sliku iz albuma nakon snimanja promena. U jednom momentu 
možete obrisati više slika. Polje Postavi za sliku albuma, daje mogućnost da ta slika postane naslovna slika albuma. 

Klikom na promeni snimate promene u albumu i dobijate poruku o uspešnosti akcije. 



 

Video galerija 
Video galerija Vam daje mogućnost postavljanja video fajlova sa servisa kao što su YouTube, Vimeo, kao i bilo kog 
drugog servisa koji dopušta uključivanje (embed) video fajlova u Vaše strane. 

Organizacija video fajlova je moguća po kategorijama. 

Nova kategorija 

Prvo trebamo upisati naziv kategorije. 

Zatim trebamo odabrati roditeljsku kategoriju ili 
kategoriju definisati kao samostalnu kategoriju.  

Opis kategorije je opcion i poželjno je upisati ga. 

Nakon klika dodaj, dobićete poruku o uspešnosti  
akcije. U slučaju uspešne akcije bićete redirekovani na 
pregled kategorija. 

 

 

 

 

 

 

 

Novi video fajl 

Potrebno je da upišemo naslov video fajla,zatim odaberemo kategoriju i upišemo opis fajla. Polje za unos opisa 
podržava napredni unos teksta. 

Nakon ovih koraka potrebno je da odemo na željeni servis i kopiramo HTML embed kod za naš video fajl. 

Za youtube ovaj kod se nalazi kada se klikne na Share dugme ispod video fajla,  pa u novo otvorenom delu klikne na 
embed. Kod kopirati i nalepiti(paste) u polje HTML kod. 

Nakon klika dodaj, dobićete poruku o uspešnosti  akcije. U slučaju uspešne akcije bićete redirekovani na pregled 
kategorija. 



 

 

Pregled video fajlova 

 

Na prvom ekranu dobićete spisak svih kategorija sa njihovim opisima. 

Ikonica olovke daje mogućnost izmene kategorije, ikonica x daje mogućnost brisanja kategorije(sa podkategorijama i 
fajlovima u njima),a ikonica lupe otvara kategoriju novom prozoru u korisničkom režimu pregleda. 

Klikom na neku kategoriju dobijate sve video fajlove u datoj kategoriji. 



 

Ikonica olovke daje mogućnost izmene fajla, ikonica x daje mogućnost brisanja fajla,a ikonica lupe otvara fajl u 
novom prozoru u korisničkom režimu pregleda.



 

Meni 
Meniji omogućavaju da bilo koju stranu linkujete iz menija koji se nalazi pri vrhu strane ili sa leve/desne strane. 

Menijima imate mogućnost da napravite strukturu sajta po Vašim potrebama i po planu koji je važan za vašu školu. 

Sistem dolazi sa dva predefinisana menija: Glavni -nije moguće njegovo brisanje, samo izmena.On služi kao primarna 
navigacija u temama i obično se nalazi na vrhu strane. 

Sekundarni meni sa leve strane u blokovima.  

Primarni meni je često ograničen brojem stavki zbog dizajna pa je potrebno ili praviti padajuće menije ili dodavati 
linkove u sekundarni meni. 

Kreiranje novog menija 

Unesite ime Vašeg menija i odaberite da li želite da meni sadrži podmenije. 

 

Dodavanje linka u meni 

Ukoliko želite da u već postojeći meni dodate novu stavku(link) potrebno je da izaberete ovu opciju. Na prvom 
ekranu potrebno je iz padajuće liste da odaberete u koji meni želite da dodate stavku. 

Upišite naslov stavke koji će se pojaviti u meniju. Zatim odaberite Roditeljsku stavku. Ukoliko odaberete „Samostalna 
stavka“ ova stavka biće dodata na kraj svih stavki u meniju. Ukoliko odaberete neku stavku, nova stavka će se videti u 
padajućem meniju kada se pređe mišem preko roditeljske stavke. 

Zatim je potrebno da uneste tip linka. Ukoliko linkujete neku stranu u okviru sistema odaberite Interni link i iz novog 
padajućeg menija odaberite stranu koju linkujete.  

Ukoliko želite da linkujete neku stranu na drugom sajtu ili neku stranu koja se ne nalazi u spisku internih strana, 
odaberite eksterni link. U polju koje će se pojaviti upišite URL do strane (kopirajte adresu željene strane iz adres bara 
internet preglednika i nalepite u ovo polje). 



  

Nakon klika dodaj, dobićete poruku o uspešnosti  akcije.  

Pregled menija 

Na prvom ekranu imate  pregled menija. 

 

 

Ikonica olovke daje mogućnost izmene menija, ikonica x daje mogućnost brisanja menija. 

Klikom na ime nekog od menija otvara se novi ekran sa svim stavkama koje ovaj meni sadrži. 

Postoji mogućnost izmene ili brisanja neke stavke menija. Klikom na strelicu na gore(ili na dole) reorganizujete stavke 
u meniju. Ukoliko se odlučite za izmenu linka menija imate mogućnost upisa novog linka (bez biranja da li je to 
interni ili eksterni link). Brisanjem Glavne stavke menija brišete i sve pod stavke te stavke. 



 



 

Blokovi 
Blokovi daju dinamički određuju izgled i funkcionalnosti sajta. Postoje 5 tipa bloka 

1. Meni blok- prikazuje izabrani meni 
2. Vesti  blok – prikazuje određeni broj vesti iz izabrane kategorije 
3. Pretraga blok – prikazuje formu za pretragu sajta 
4. Admin login blok- prikazuje formu za logovanje u administraciju 
5. HTML blok- uz pomoć naprednog unosa teksta moguće je postavljati banere, ikonice ka društvenim mrežama 

i sl stvari. 

Novi blok 

 Upišite naslov bloka,a zatim odaberite tip bloka. U 
zavisnosti od izabranog tipa dobićete dodatna polja za 
izbor. Sledeći korak je da podesite status bloka aktivan ili 
neaktivan. Ukoliko se odabere status neaktivan blok neće 
biti prikazivan. Ova opcija se može iskoristiti za vreme 
pripreme bloka. 

Nakon dodavanja bloka dobićete poruku o uspešnosti 
akcije. 

Pregled blokova 

Na ovoj stranici možete videti sve blokove, kog su tipa i 
njihov status.  

Ikonica olovke označava mogućnost promene bloka, a 
ikonica x brisanje bloka. 

Klikom na strelicu na gore ili na dole pomerate blok gore ili 
dole u prikazu. 

 



 

Korisnici 
Ovim modulom možete odrediti nivo pristupa delovima sajta. Možete kreirati super korisnike(administratore) ili 
naloge koji imaju pristup samo nekim modulima i kategorijama. 

Kreiranje novog korisnika 



  

Prilikom kreiranja novog korisnika potrebno je upisati korisničko ime i šifru korisnika(dva puta).  Ukoliko želimo da 
korisnik bude administrator čekiramo super korisnik. Ukoliko želimo da ima pristup samo nekim modulima, čekiramo 
željene module. Ukoliko se odabere modul Strane ili download na sledećoj strani se bira kojim kategorijama nalog 
ima pristup. Preglednik fajlova je modul koji je potreban da ide uz korisnike koji imaju pristup naprednom dodavanju 
teksta tj. za module strane,vesti,download,Video,Blokovi. 

 

 

 

 

 

 



 

Pregled korisnika 

Na ovoj strani imate uvid u sve korisnike sistema. Klikom na ikonicu olovke imate mogućnost promene prava pristupa 

i šifre. Klikom na ikonicu x brišete korisnika iz sistema. 



 

Dodatak: Rad sa editorom teksta 

 

Editor teksta daje mogućnost naprednog unosa teksta, tj postavljanja slika, linkova, promena veličine, boje, tipa 
fonta, unos simbola i sl. Interfej je sličan Microsoft Office 2003 programu, pa bi korisnici trebali biti upoznati sa 
mogućnostima programa uz manje izmene koje se odnose na web tehnologiju.  

Na sledećim slikama označene su funkcije pojedinačnih ikonica u toolbarovima. 

 



 

 

Nova dugmad koja su za korisnike od interesa su: Paste , Paste as text , Paste from word  koja se nalaze 
na prvom toolbaru. 

Običan Paste se trudi da zadrži formatiranje originalnog teksta. Problem nastaje ukoliko u tekstu postoje slike pa nije 
moguće kroz internet preglednik poslati na stranicu. Ovo ograničenje je u samom načinu funkcionisanja internt 
preglednika (Firefox, Chrome, Opera, Internet Explorer) i ne postoji način za njegovo zaobilaženje. U tom slučaju 
potrebno je uraditi Paste as plain text, pa naknadno formatirati tekst i ubaciti slike na stranicu. 

Ukoliko imate dokument koji ste pripremili u Word programu potrebno je da koristite treće dugme Paste from Word. 
Ovim dugmetom će te u najvećoj meri zadržati formatiranje iz word-a, uz uklanjanje slika zbog pomenutog 
ograničenja. Slike je potrebno naknadno ubaciti u stranicu. 

Ukoliko prilikom rada naiđete na problem sa formatiranjem, selektujte deo teksta sa kojim imate problem i pritisnite 
dugme Ukloni formatiranje(prvi red,prvo sa desne strane).  Ukoliko i dalje imate problema pritisnite dugme označi 
sve(prvi red, drugo sa desne strane), pa onda dugme ukloni formatiranje(odmah pored). Ovime će te obrisati svako 
formatiranje teksta. 



Ukoliko poznajte HTML u režimu pregleda koda (prvi red, prvo dugme) možete direktno unositi HTML. 

Ubacivanje slike 

Česta operacija je dodavanje slike u dokument. Pozicionirajte kursor u tekstu na mesto na koje želite da umetnete 

sliku. Pritisnite dugme za unos slike   (drugi red, 4 sa desne strane). Otvoriće vam se novi dijalog kao na slici ispod. 

 

Kliknite na dugme Pretraži server kako bi otvorili preglednik fajlova na serveru. Uz pomoć preglednika fajlova možete 
izabrati ili postaviti sliku sa Vašeg računara. Dva puta kliknite na željenu sliku da zatvorite dijalog. Detaljan rad sa 
preglednikom fajlova je opisan u dodatku. Nakon zatvaranja dijaloga u prvom dijalogu će te videti prikaz vaše slike i 
neka polja automatski popunjena. Odaberite poravnanje slike pored teksta (Levo, Desno). U polja Hspace i Vspace 
možete upisati vrednost koja predstavlja odstojanje slike od teksta. Unosom vrednosti 5 se postiže dobro odvajanje i 
preglednost. Vrednost je u pikselima. U polje alternativni tekst možete upisati opis slike. Ovaj tekst koriste čitači 
ekrana koje koriste osobe sa invaliditetom. Polje okvir predstavlja debljinu okvira oko slike. U većini slučajeva ovo 
polje nije potrebno popuniti. Kada završite sa radom kliknite dugme OK. 

Ukoliko niste zadovoljni sa dobijenim rezultatom i želite da izvršite izmenu to možete učiniti na dva načina. Kliknite 

levim tasterom miša na sliku iz toolbara kliknite na ikonicu  za unos slike. Drugi način je da kliknete desnim 
tasterom miša na sliku i izaberete Osobine slike. 

Veličinu slike možete podesiti tako što ćete kliknuti jednom levim tasterom miša na sliku, a zatim kada se pojavi okvir 
sa kockicama oko slike, kliknuti i držati neku od kockica. Pomerajte miš dok ne dobijete željenu veličinu slike i onda 
otpustite taster. Preporuka je da optimizujete slike na željene dimenzije pre postavljanja slika na server, jer onda 
nećete opterećivati korisnika skidanjem velike slike. 

 



Linkovanje druge strane 

Link predstavlja vezu između dve strane. Da biste napravili vezu selektujte tekst koji želite da bude link. Zatim 

pritisnite dugme . Otvoriće vam se prozor kao na slici.  

 

Ukoliko želite da linkujete neku stranu na sajtu koju ste pisali iz padajuće liste „Strana na sajtu“ izaberite naslov 
strane. Naslovi su dati kao naslov grupe kojoj strana pripada i naslova same strane. Kliknite ok. 

Ukoliko želite da linkujete neki fajl na serveru(ili želite da postavite fajl na server) kliknite na dugme pretraži server. 
Otvoriće Vam se novi dijalog. Odaberite ili postavite Vaš fajl. Dvaput kliknite na ime fajla da zatvorite dijalog. Kliknite 
ok. 

Ukoliko želite da linkujete neku stranu van sajta u polje URL upišite ili nalepite adresu strane i kliknite dugme OK. 

Ukoliko želite da izmenite link selektujte tekst i kliknite na dugme za unos linka. Drugi način je da desnim klikom 
kliknete na link i odaberete promeni link. 

Ukoliko želite da uklonite link selektujte tekst i kliknite dugme  pored dugmeta za unos linka. Drugi način je da 
desnim tasterom miša kliknete na tekst i odaberete ukloni link. 

Unos tabele 

Čest slučaj je potreba za tabelarnim prikazom podataka. Kliknite na dugme . Otvoriće Vam se novi dijalog kao na 
slici ispod. Upišite broj redova i kolona. Možete upisati širinu i visinu tabele u piskelima ili procentima dodavanjem 
znaka % iza broja(maks 100%). Okoliko želite da vaša tabela nema vidljiv okvir u polje Veličina okvira upišite 0. 
Odaberite način ravnanja tabele (levo, desno, sredina). Kliknite ok. U polju za unos teksta će te imati isrctranu tabelu. 
Ukoliko ste za veličinu okvria uneli 0, okvri tabele će biti isrctan isprekidanom linijom. 

Popunite željena polja tebele. 

Kao i kod Microsoft Worda, desnim klikom na tabelu dobijate mogućnost dodavanja i brisanja kolona i redova. 
Ukoliko želite da više ćelija spojite u jednu selektujte ćelije, pritisnite desni taster miša i odaberite Ćelije -> Spoji 
ćelije. 



Dodatak: Rad sa preglednikom fajlova 
Preglednik fajlova Vam daje mogućnost postavljanja, uređivanja i izbora fajla iz različitih dijaloga sistema. 

Na sledeće dve slike su prikazane funkcije preglednika. 

 

 

Fajlove je poželjno da organizujete po folderima. Kretanje kroz foldere je dvostruki klik. Odabir fajla možete izvršiti 
dvostrukim klikom ili selektovanjem fajla levim klikom miša i klikom na dugme za odabir fajla. 

Kreiranje foldera se vrši klikom na dugme . Pojaviće se novi folder. Upišite ime i pritisnite enter na tastaturi. 



Ukoliko želite da postavite fajlove na server, pritisnite dugme . U novom dijalogu odaberite fajlove sa svog 
računara. Pritisnuti OK i sačekati dok se fajlovi ne postave na server.Vremensko trajanje postavljanja zavisi od 
veličine fajla i internet konekcije.  Nakon što se završi postavljanje fajlova videćete nove fajlove u spisku. Odaberite 
fajlove na gore opisan način. 

Ukoliko folderu ili fajlu želite da promenite ime, kliknite na fajl, pa zatim na dugme . Upišite novo ime i pritisnite 
enter na tastaturi.  

Ukoliko želite da promenite veličinu slike pritisnite dugme  nakon što ste odabrali sliku. U novom prozoru upišite 
dimenczije slike. 

Brisanje fajla možete izvršiti selektovanjem fajla levim klikom i pritiskom na dugme . Dobićete pitanje da 
potvrdite akciju. Ukoliko ste sigurni pritisnite dugme OK. 



 

Dodatak: IrfanView 
Program IrfanView omogućava pregled slika, uz jednostavnu primenu i obradu poput: promene veličine slike, 
konvertovanja u drugi format, dodavanja efektra isl. Program je besplatan i pogodan za škole. 

Od interesa za nas je funkcija promena veličine slike. 

Startujte program. Otvorite sliku izborom menija File -> Open i odaberite željenu sliku.  

 

Program će prikazati brojem sve slike u folderu, pa se kroz njih možete kretati klikom strelice napred ili nazad. 

Da bi promenili veličinu slike kliknite meni Image-> Resize/Resample. Prečica na tastaturi je ctrl+r. 



Otvoriće Vam se dijalog kao na slici ispod. 

 

Odaberite radiobox 800x600 Pixels (označen na slici) i kliknite ok ukoliko spremate slike za album. 

U suprotnom upišite dimenzije u polje width za širinu slike i kliknite OK. 

 Slike je promenila veličinu. Sada je potrebno da je sačuvamo. Sliku možemo sačuvati kao novu sliku ili preko 
postojeće čime brišemo originalnu sliku pune dimenzije. 

Ukoliko želite da sačuvate kao novu sliku, kliknite meni File -> Save as (prečica na stastaturi S). 

Odaberite mesto gde želite da sačuvate sliku, upišite naziv i kliknite OK. 

Ukoliko želite da sačuvate preko originalne slike, kliknite meni File -> Save(original folder) (prečica na tastaturi ctrl 
+s). Kliknite ok u novom dijalogu i yes u novoj poruci. 

Možete preći na sledeću sliku klikom na  strelicu . 

Kada ste završili sa promenom veličine slika, promenjene slike postavite na internet. 



 

Dodatak: Trikovi  
U ovom delu biće pokrivene neke tehnike i upustva koja nisu pokrivena drugim delovima upustva. Sekcija će se 
vremenom dopunjavati Vašim čestim pitanjima. 

Postavljanje Facebook fun page like box 

Ukoliko imate Facebook stranu  Vaše škole možete omogućiti korisnicima da je lajkuju koristeći facebook plugin pod 
nazivom likebox. 

Preduslov za ovo upustvo je da imate kreiranu facebook stranu. 

Idite na stranu https://developers.facebook.com/docs/reference/plugins/like-box/ 

Za polje Facebook Page URL upišite (nalepite) URL vaše fun strane. 

Upišite veličinu (width). Minimalna veličina je 292 piksela. 

Odaberite šemu boja koja odgovara vašoj temi. U ponudi su dve šeme light svetla I dark tamna šema. 

Čekirajte polje Show stream ukoliko želite da se prikazuje deo Vašeg zida . 

Čekirajte polje show header ukoliko želite da se pojavljuje opis vaše strane. 

Sve izmene koje napravite se automatski prikazuju sa desne strane 

Pritisnite dugme get code. 

U novom prozoru kojie se otvori kliknite pri vrhu na IFRAME. Kopirajte kod koji Vam se pojavi u polju ispod. 

Napravite novi blok. Za tip odaberite HTML blok. U polju za unos HTML teksta pritisnite na dugme   (prvo u 
prvom redu). Zalepite dobijeni kod u polje. Ponovo pritisnite dugme za kod. Pisaće Vam crvenim slovima iframe. 
Dodajte blok. Facebook like box će sada biti vidljiv svim posetiocima. 

 

 

Facebook i Youtube ikonica (dugme) 

Ukoliko želite da postavite facebook dugme ka Vašoj strani ili youtube dugme ka Vašem youtube kanalu spremili smo 
Vam dve ikonice za to i kratko upustvo. 

Kreirajte novi blok, odaberite za tip HTML blok. Kliknite na ikonicu za unos slike . Kliknite na dugme pretraži 
server. U folderu ikonice odaberite facebook ili youtube ikonicu. Kliknite dvaputa da zatvorite preglednik fajlova,  

Odaberite poravnjanje i kliknite ok. Kliknite na ikonicu a zatim na dugme za unos linka . Upišite link do Vaše 
facebook strane ili youtube kanala.  Kliknite ok. 

Ukoliko želite da dodate obe ikonice ponovite postupak. Po završetku kliknite dodaj blok. 

 



 

Strana podeljenja po kolonama 

Ukoliko želite da vaša strana ima više kolona, kao na primer početna strana na kojoj želite da sa po jednim 
paragrafom predstavite više stvari to možete učiniti na sledeći način. 

U ovom primeru će biti demonstrirano kreiranje 3 kolone. 

Kolone se postižu unosom nevidljive tabele, sa 3( ili 2 ) kolone i jednim redom u okviru kojih se postavlja sadržaj. 

U polju za unos teksta kliknite na dugme . Otvoriće Vam se novi dijalog.  

Za broj kolona upišite 3, za broj redova 1, a za veličinu okvira 0. Ukoliko želite da rastojanje između kolona bude veće 
za Razmak ćelija upišite broj veći od 1. Ovaj broj je u pikselima.  

Za širinu tabele upišite 100%. Bitno je da tabela bude 100% (prilagodiva) kako bi odgovarala svakoj temi i izgledima. 
Ukoliko bude fiksan broj u pikselima(a ne procentima) tabela možda neće odgovarati svim stranama i može se destiti 
da razvlači dizajn. 

 

Kliknite OK. 

U polju za unos teksta će isprekidanim linijama biti iscrtana tabela i njena polja. Upišite željeni sadržaj u kolone 
tabele. 

Prilikom unosa teksta ćelija može da menja veličinu. Ukoliko želite da sve ćelije imaju istu širinu kliknite desnim 
mišem na ćeliju odaberite Cell -> Cell properties. Za širinu upišite broj koji odgovara razlomku 100%/broj kolona. Za 
jedinicu iz padajućeg menija odaberite procenat. Ponovite ovo i za ostale ćelije. Ukoliko imate dve kolone upisaćete 
50. Ukoliko imate tri kolone upisaćete za prve dve kolone 33, a za poslednju 34. 

Primer jednog takvog sadržaja je na slici ispod. 



 

Na kraju svakog paragrafa možete ostaviti link pročitaj više ukoliko na ovaj način pravite početnu stranu. 

 

 


